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PREFACE

Thank you for purchasing the SecurView Wireless N Day/Night Pan/Tilt
Internet Camera, a powerful dual-codec wireless network camera with the
2-way audio function that provides the high-quality image and on-the-spot
audio via the Internet connection. The Infrared LEDs and light sensor
enable the camera to capture images even in the dark environment. The
camera’s pan/tilt functions allow you to control the camera to monitor
everywhere remotely. Through the GPIO connectors, the camera can
attach a variety of external devices for your specific purposes. The camera
can be installed as a standalone system within your application
environment easily and quickly, and supports remote management
function so that you can access and control it using a Web browser on your
PC.

This Advanced Installation Guide provides you with the instructions and
illustrations on how to use your camera, which includes:

Chapter1 Introduction to Your Camera describes the features of the
camera. You will also know the components and functions of
the camera.

Chapter 2  Hardware Installation helps you install the camera according
to your application environment. You can use this camera at
home, at work, at any where you want.

Chapter 3  Accessing the Camera lets you start using your camera
without problem. The camera can be set up easily and work
within your network environment instantly.

Chapter 4  Configuring the Camera guides you through the configuration
of the camera using the Web browser on your PC.

Chapter5 Appendix provides the specification of the camera and some
useful information for using your camera.
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CHAPTER 1

INTRODUCTION TO YOUR
CAMERA

1.1 Checking the Package Contents

Check the items contained in the package carefully. You should have the
following:

One TV-IP422WN

One Power Adapter

One External Antenna

One Camera Stand /Mounting Kit

One GPIO Connector

One Network Cable

One CD-ROM (Utility & User’s Guide)

One Multi-Language Quick Installation Guide

NENNRANRNRNR

NOTE Once any item contained is damaged or missing, contact the
authorized dealer of your locale.



1.2 Getting to Know Your Camera

Light Sensor

is used to trigger on and off the
Infrared LEDs according the
environmental light level.

Infrared LEDs (x7)
allow your camera to
capture clearimage in
a dark environment.

o \. USB Port*
) allows you to connect an
external USB device. It
provides the power
ﬂé distribution up to 500mA.
1

Power LED
indicates the camera
is powered on with
the steady amber
light.

Link LED Internal Microphone
indicates the camera’s allows the camera to
network connectivity receive sound and voice.
with the flashing green
light.

Front View



External Antenna
Connector connects the
external antenna.

Ethernet Cable Connector
connects the network cable.

DC Power Connector
connects the AC power
adapter, in order to
supply power to the
camera.

Audio-out Connector
connects an external
active speaker.

WPS button
Used to connect to your
encrypted Wireless
network

Reset Button

GPIO Connectors will restart the camera when it is
is used to connect the pressed quickly; when it s
external devices. pressed and held for five

seconds, the camera will resume
the factory default settings.

Rear View



1.3 Features and Benefits

MPEG4/MJPEG Dual-codec Supported

The camera provides you with excellent images by the MPEG4/ MJPEG
dual-codec selectable technology, allowing you to adjust image size and
quality, and bit rate according to the networking environment.

2-way Audio Capability

The built-in microphone of the camera provides on-the-spot audio via the
Internet, allowing you to monitor the on-site voice. In addition, you can
connect an external speaker to the camera to speak through the camera.

Day & Night Surveillance Supported

The seven Infrared LEDs around the standard lens assembly enable the
camera to capture crystal clear images in the dark environment or at night.
When the Light Sensor detects the environmental light level becomes low,
the camera captures the images in black & white mode using these
infrared LEDs.

Optimal Viewing

With the pan/tile functions, you can easily monitor everywhere via the
camera by moving the camera lens to the left/right (165/165 degrees) or
up/down (90/15 degrees). In addition, you can assign up to eight positions
for the camera, enabling you to move the camera lens to the desired
position quickly.

Supports RTSP

The camera supports RTSP (Real Time Streaming Protocol), which is a
technology that allows you to view streaming media via the network. You
can view the real-time video with the Quick Time player or RealPlayer. To
view the real-time streaming image on your computer, open the Web
browser and enter the RTSP link: rtsp://(IP address of the camera)/3gp




Supports Multiple Profiles

The camera supports multiple profiles simultaneously, so that you can
separately set up different image settings (such as image quality and
frame rate) for the three video types of the camera: MPEG4, MJPEG, and
3GPP.

1/0 Connectors Provided

The camera provides the 1/0 connectors on the rear panel (IN/OUT),
which provide the physical interface to send and receive digital signals to
a variety of external alarm devices. You can connect a special featured
device, and then configure the settings and control the device from the
GPIO Trigger window of Web Configuration.

Remote Control Supported

By using a standard Web browser or the bundled SecurView Pro software
application, the administrator can easily change the configuration of the
camera via Intranet or Internet. In addition, the camera can be upgraded
remotely when a new firmware is available. The users are also allowed to
monitor the image and take snapshots via the network.

Supports Connection to the External Devices

With the auxiliary Input/Output connectors, you can connect the camera
to a variety of external devices, such as the external speaker and the USB
device.

Multiple Platforms Supported

The camera supports multiple network protocols, including TCP/IP, SMTP
e-mail, HTTP, and other Internet related protocols. Therefore, you can use
the camera in a mixed operating system environment, such as Windows
Vista and Windows 7.

Multiple Applications Supported

Through the remote access technology, you can use the cameras to
monitor various objects and places for your own purposes.

For example, babies at home, patients in the hospital, offices and banks,
and more. The camera can capture both still images and video clips, so
that you can keep the archives and restore them at any time.

-8-



1.4 System Requirement

Networking

LAN: 10Base-T Ethernet or 100Base-TX Fast Ethernet.
WLAN: IEEE 802.11b/g, Based on IEEE 802.11n Technology

Accessing the Camera using Web Browser

Platform: Microsoft® Windows® 2000/XP/Vista/Win7
CPU: Intel Pentium Il 800MHz or above

RAM: 512MB

Resolution: 800x600 or above

User Interface: Microsoft® Internet Explorer 6.0 or above

Accessing the Camera using SecurView Pro

Platform: Microsoft® Windows® XP/Vista/Win7
Resolution: 1024x768 or above

Hardware Requirement:

1~8 cameras: Intel Core 2 Duo 2GB RAM
9~32 cameras: Intel Core 2 Quad 4GB RAM

NOTE If you connect multiple cameras to monitor various places

simultaneously, you are recommended to use a computer with

higher performance.



CHAPTER 2

HARDWARE INSTALLATION

2.1 Installing the Wall Mount Kit

The camera comes with a Wall Mount Kit, which allows you to place your
camera anywhere by mounting the camera through the three screw holes
located in the base of the Wall Mount Kit.

-
-
-

-
&

=1
T Screw
|
Screw
= Screw Wall Mount Kit
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2.2 Connecting the Camera to LAN/WLAN

Use the provided Ethernet cable to
connect the camera to your local area
network (LAN).

When you connect the AC power

adapter, the camera is powered on "
automatically. You can verify the »
power status from the Power LED on

the front panel of the camera. ~ / J i
. H-e
Once connected, the Link LED starts U -

flashing green light and the camera is
on standby and ready for use now.

Connecting the Ethernet Cable

If you use a wireless network in your

application environment, you need to
attach the included external antenna

to the camera.

When the camera is powered on, the
camera will automatically search any
access point with “default” SSID.

Connecting the External Antenna

NOTE If the camera cannot to your wireless network, you need to install
the camera in LAN and proceed with WLAN settings.

-11-



2.3 Applications of the Camera
The camera can be applied in multiple applications, including:

B Monitor local and remote places and objects via Internet or Intranet.
B Capture still images and video clips remotely.

B Upload images or send email messages with the still images attached.

The following diagram explains one of the typical applications for your
camera and provides a basic example for installing the camera.

Home Applications

-12-



CHAPTER 3

ACCESSING THE CAMERA

3.1 Using IPSetup

The camera comes with a conveniently utility, IPSetup, which is included in
the Installation CD-ROM, allowing you to search the camera on your
network easily.

1. Insert the Installation CD-ROM into your computer’s CD-ROM drive to
initiate the Auto-Run program.

2. Click the IPSetup item to launch the utility. The control panel will
appear as below.

& ¥ Finder %
Display the connected
I 192,16, 0,30 IP Camera M=FFA0:20:02:05 I ‘— camera(s).
Double click to link the
Camera.

| [ Aot J| Link || Change IP |. Search | Bdt | |4—|

Click About to get the Version information of IPSetup.

Click Link to connect the selected camera.

Click Change IP to modify the IP address of the selected camera.
Click Search to find the IP address of the connected camera(s).
Click Exit to close the utility.

3. Once you get the IP address of the camera, launch the Web browser
or SecurView Pro to access your camera.

-13-



3.2 Accessing to the Camera

Whenever you want to access the camera:

1. Since the default configuration of the camera is DHCP mode enabled,
you are recommended to launch IPSetup to search the IP address that
is assigned to the camera by the DHCP server, and then click Link to
access the camera via the Web browser.

2. If Network Camera can't get IP Address under DHCP mode, the default
IP Address will be 192.168.10.30.

3. When the login window appears, enter the default User name (admin)
and password (admin) and press OK to access to the main screen of
the camera’s Web Configuration.

Connect to 192.168.1.40

2%
HrR

I

The server 192. 168, 1.40 at netcam requires a username and
password.

Warning: This server is requesting that your username and
password be sent in an insecure manner (basic authentication
without a secure connection).

User name: [ 4 Enter the User name

Password: and Password.

|| Remember my password

NOTE If you are initially access to the camera, you will be ask to install a
new plug-in for the camera. Permission request depends on the
Internet security settings of your computer. Click Yes to proceed.

-14-



After you login into the Web Configuration of the camera, the main page
will appear as below:

Pan/Tolt Wireless Netwark

http:/, ] B ‘admin/view.cqilprofile= | R A Live § h -
] 1921681 4/acl qitprofile=0 i3 |4 17 Live Search 2

U Favortes | g8 PanyTilt Wireless Metwork Camers i = B - [0 o = Bage= Gafety -

S Wiralass N D
@ TREnDnET a;ar'ln,-"T|iL._,.-'Zu::lT:LHur'nuav

a8
TWIPa22WN

Live View/Setup Switch 7 In Butt Loc 2001 8 |
- T e

Nightmode Button

Live View Image

Manual Record

Snapshot

S Function Buttons

Talk
Listen

Trigger Out

Done & Intemet | Protected Mode Off fa v HI00% -

The main page of the Web Configuration provides you with many useful
information and functions, including:

B Camera Information — Displays the camera’s location and the current
date & time. The information can be modified in the Web
Configuration.

-15-



B Live View Image — Displays the real-time image of the connected
camera.

® Move your mouse to the Live View area and click on anywhere,
the camera lens will then move to the position where you clicked
to display it in the central part of Live View area.

® When you enlarge the Live View by clicking the Zoom In buttons
(2x or 3x), you can move the displayed image by right-clicking
your mouse on the Live View area. The position where you right-
clicked will be displayed in the central part of Live View area.

B Zoom In Buttons — Click the buttons to zoom in the live view image by
1x, 2x, and 3x.

B Nightmode Button — Click the button to enable the “nightshot mode”
to deliver clearer images in the dark environment. However, this will
reduce the frame rate of video setting.

B Live View/Setup Switch — Click Setup to configure the camera. For
details, see Chapter 4 and Click the Live View button to return to the
Main screen to view the live view image.

B Compression Buttons — Select to transmit and record the video using
MPEG4 or MJPEG compression.

B Pan/Tilt Buttons — Provides the buttons to control the camera lens:

@ Left/Right/Up/Down/Home buttons allow you to move the
camera lens position. Clicking the Home button will move the
camera lens to the assigned home position.

® Auto Patrol button controls the camera to automatically scan the
preset positions once. Click Stop to stop patrolling.

® Click the Number button (1~8) to move the camera lens to the
preset position immediately.

To set up the preset positions, move the camera lens by clicking
the Left/Right/Up/Down buttons to the desired position first, then
- ]6 -



select the number (1~8) from the pull-down list and click the
Apply button. You can enter a descriptive name for the assigned
position in the text box to identify it easily.

B Function Buttons — Use these buttons to control the audio, video, and
trigger functions.

® Manual Record allows you to record and save a video clip.
® Snapshot allows you to capture and save a still image.

® Browse allows you to assign the destination folder to store the
video clips and still images.

® Talk allows you to speak out through the camera. Please note
only one user is allowed to use this function at a time.

® Listen allows you to receive the on-site sound and voice from the
camera.

® Trigger Out allows you to trigger on/off the GPIO output manually.

NOTE If your PC use Microsoft Vista platform. Maybe you can’t find these
recorded files what stored by Snapshot or Manual Record. That
you need to disable the protected mode of Security in the IE
Browser. Please follow as below Steps:

1. Open IE Browser

2. Select Tools=> Internet Options

3. Select Security

4. Disable the "Enable Protected Mode” then press OK

-17 -



3.3 Configuring the IP Address of the PC

If you are failed to access to the camera, please check the IP address of
your computer. When you connect the camera to your computer directly
to proceed with configuration of the camera, you need to set up the IP
addresses to be in the same segment for the two devices to communicate.

1.

On your computer, click Start > Control Panel to open the Control
Panel window.

Double-click Network Connection to open the Network Connection
window.

Right-click Local Area Connection and then click Properties from the
shortcut menu.

When the Local Area Connection Properties window appears, select
the General tab.

Select Internet Protocol [TCP/IP] and then click Properties to bring up
the Internet Protocol [TCP/IP] Properties window.

To configure a fixed IP address that is within the segment of the
camera, select the Use the following IP address option. Then, enter an
IP address into the empty field. The suggested IP address is
192.168.10.x (x is 1~254 except 30), and the suggested Subnet mask is
255.255.255.0.

When you are finished, click OK.

-18 -



CHAPTER 4

CONFIGURING THE CAMERA

4.1 Using the Web Configuration

You can access and manage the camera through the Web browser and the
provided software application SecurView Pro. This chapter describes the
Web Configuration, and guides you through the configuration of the
camera by using the Web browser.

To configure the camera, click Setup on the main page of Web
Configuration. The Web Configuration will start from the Basic page.

SecurView Wireless N Day/Nig
Pan/Tilt/Zoom Interne:

ideo RGdie The Web Configuration contains the
settings that are required for the camera in
the left menu bar, including Smart Wizard,
Basic, Network, Video/Audio, Event
Server, Motion detect, Event Config,

S Tools, USB, and Information.

usg

Event Server
Matic

Evant Config

Device Info

011 TR MOt A8 Fighes Fessrved

Dane @ lvermet | Proected Mose OM v RI0N .
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4.2 Using Smart Wizard

The camera’s Smart Wizard lets you configure your camera easily and
quickly. The wizard will guide you through the necessary settings with
detailed instructions on each step.

To start the wizard, click Smart Wizard in the left menu bar.

Step 1. Camera Settings

Basic » System

Basic

Enter the name for the
Camera Name: TV-IP422WH| camera and place.

Location:

Enter the administrator

Indication LED password.

Indication LED control: @ Normal & OFF

Step 2. IP Settings

IP Settings

@ DHCP

Static IP
P

Select the IP setting
according to your

Default Gateway . . I network: DHCP,
Static IP, or PPPoE.

Subnet Mask

Primary DNS

Secondary DNS

PPPOE
User Name
Password

-20-



Step 3. Email Settings

Email Settings

SMTP Server Address:

Enter the required
Port Number: > information to be
Encrypted connection: ssL [ STARTTLS able to send email
with image.

Sender Email Address:

Authentication Mode: 9 None SMTP

Sender User Name:

Sender Password:

Receiver #1
Email Address:

Receiver #2
Email Address:

Step 4. Wireless Networking

Wireless Networking

Network ID(SSID): TRENDnet Site Survey

Wireless Mode: @ Infrastructure Ad-Hoc

Channel:

Complete the
Authentication: Open [] required settings for
wireless networking.

Encryption: @ None O WEP

Format: 9@ ASCII HEX

Key Length: @ 54 bits 128 bits

9 WEP Key 1:

WEP Key 2:

WEP Key 3:

WEP Key 4:

__ : |




Step 5. Confirm Settings

Confirm Settings

Camera Name:

Location:

IP Mode: DHCP

IP Address: 192.168.10.30
Subnet Mask: 255.255.255.0
Default Gateway: 192.168.10.1
Primary DNS;

Secondary DNS:

SMTP Server Address:

Port Number: 25
SSL Disable
STARTTLS: Disable

Sender Email Address:

Authentication Mode: None

Sender User Name:

Receiver #1 Email
Address:

Receiver #2 Email

Address:

ESSID: Trendnetskyh
Connection: Infrastructure
Channel: 6
Authentication: WPA2-PSK
Encryption: AES

This step shows the configuration of your camera. When you confirm the
settings, click Apply to finish the wizard and reboot the camera. Otherwise,
click Prev to go back to the previous step(s) and change the settings; or
click Cancel to end the wizard and discard the changes.

-22-



4.3 Basic Setup

The Basic menu contains three sub-menus that provide the system settings
for the camera, such as the Camera Name, Location, Date & Time, and
User management.

Basic >> System

1 /AT IGR A acderiey gt

op Favermes g Pan/Tik Wareless Netwerk Cansera G-8 - m v Pagew Gfety

@ TREnDnET SecurViiow Wireless N Day,”Night

Pan/Tilt/ Zoom Internot

Basic » System

| O Setup |

P —
Smart Wizard

Basic

* frslom
= Dute & Time
e
Network
P ——
Tilt
Video, Audia

e ——
Event Server

R
Mation Detact

m—
Event Config

e
Tools

use

Device Infa

Copyright © 2017 TRINDnet. Al Fights Fsserved

Done @ Inteemet | Pretected Mode: Off fa - RN -

B Basic
- Camera Name: Enter a descriptive name for the camera.

- Location: Enter a descriptive name for the location used by the
camera.

-23-



B Indication LED

This item allows you to set the LED illumination as desired. There are
two options: Normal and OFF.

Basic >> Date & Time

SecurView Wireless N Day,/Night
Pan,/Tilt/Zoom Internct ra
TV-IP422WN
Location: 201101
Basic » Date & Time
Date and Time

(GMT-08:00) Pachc Time{US & Canada). Tiuana

@ Syncheonize with PC

Update intaral E = nows
Manual

Dats 2010128 (rYrMWDD)
—————
Netwerk Time: 13:30:02

[ ooty Cancer ]

P
—————
Video, Audio

—————
Event Server

—————
Meotion Detect

P——
Event Config

P—
Tools

o

usE

e —
Device Info

Copyright € 2011 TRENDnet. AN Rights Reserved

Done @ Internet | Protected Mode: OFf v R1wx -

- TimeZone: Select the proper time zone for the region from the pull-
down menu.

- Synchronize with PC: Select this option and the date & time settings
of the camera will be synchronized with the connected computer.

-24-



- Synchronize with NTP Server: Select this option and the time will be
synchronized with the NTP Server. You need to enter the IP address
of the server and select the update interval in the following two
boxes.

- Manual: Select this option to set the date and time manually.

Basic >> User

op Faverites @8 Pan/T Wireless Network Camera wm v Page~w Safety~

iew Wi N Day,/Night
t/Zoom Internet Camera
TwPaz2wn

Location: 201101/28 13:30:34

[ Live View | Basic » User
00 Setup User Accounts

Administrator: Passwora
Smart Wizard Canfiim Password

T ——
Basic Uzer Name:

* System Fassword | AddModify

* Date & Time

- user 1
Userlist Dheliede

Network
Uzer Name:
Pan/Tilt

Password [ AddModdy
Video,/ Audio
UsedList Delete
Event Server .

Direct Video Stream e
v ¥|Enable Appi
Mation Detect Authenticaton: | AR

P —
Event Config

Deavice Info
Copyright © 2017 TRENUnet. All Hights Heserved.

Done & Intemet | Protected Mode: OFf fa v HINE -
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B Administrator

To prevent unauthorized access to the camera’s Web Configuration,
you are strongly recommend to change the default administrator
password. Type the administrator password twice to set and confirm
the password.

B General User

User Name: Enter the user’s name you want to add to use the
camera.

Password: Enter the password for the new user.

When you are finished, click Add/Modify to add the new user to the
camera. To modify the user’s information, select the one you want
to modify from UserList and click Add/Modify.

UserlList: Display the existing users of the camera. To delete a user,
select the one you want to delete and click Delete.

B Guest

NOTE

User Name: Enter the guest’s name you want to add to use the
camera.

Password: Enter the password for the new guest.

UserlList: Display the existing guests of the camera. To delete a user,
select the one you want to delete and click Delete.

The “General User” can access the camera and control the Function
buttons of the camera’s Web Configuration; the “Guest’ can only
view the live view image from the main page of the Web
Configuration while accessing the camera. Only the “Administrator”
is allowed to configure the camera through the Web Configuration.

-26-



B Direct Video Stream Authentication

To steam the video directly without going through the configuration
page, you can access it via http://cameralP/jpgview.htm (eg.
http://192.168.10.30/jpgview.htm)

- Enable: User needs to enter user name and password to stream
the camera.

- Disable: User can stream the camera without entering the user
name and password.

NOTE This feature is enabled by default, and for security reason, it is
recommended to have the feature enabled at all time.

Wireless Network
] hetp://192 168 10 30/ fpguiew. htm| v | k2| | % JAT Live Search P
Gup Faverites | @8 Wireless Network Camers 5 - B -2 & = Pager Safety~

Done & Internet | Protected Mode Off fa v H1WE -
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4.4 Network Settings

The Network menu contains three sub-menus that provide the network
settings for the camera, such as the IP Setting, DDNS Setting, IP Filter, and
Wireless network.

Network >> Network

VRN LT WWIEICES NETWONE LAMER - WINGOWS Nicmet

po//192.168.1.4/ 84

¢ Favorites 8 Pany T Wireleos Netwerk Camera mm v Pagew Safety~w

Location: 201107728 133111

Smart Wizard
[

Basic Subnet Masic

_—
Network Default Gateway.
Prirmary NS

Secondary DNS.

User Name:

Fasgword

e _ X
Event Se . : Enable

PoET— Froviger: werew. dyndns.com
Motion C

Host Name:

Event Config User Name

PE——— a
oo Pagsward:

Enable

4| Enabie

Friendly Narm:

Posts Number: HTTP Port (default 80)

RTSP Fort 4 (default 554)

Enable

HITPS Port 4 (detault 443)

Copyright © 20717 THENDneE. All Rights Heserved.

Done @ Intemet | Protected Mode: Off v RI0% -
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B |P Setting

This item allows you to select the IP address mode and set up the
related configuration. The default setting is DHCP mode enabled.

- DHCP: Select this option when your network uses the DHCP server.

When the camera starts up, it will be assigned an IP address from
the DHCP server automatically.

- Static IP: Select this option to assign the IP address for the camera
directly. You can use IP Setup to obtain the related setting values.

IP

Enter the IP address of the camera. The default
setting is 192.168.10.30.

Subnet Mask

Enter the Subnet Mask of the camera. The
default setting is 255.255.255.0.

Default Gateway

Enter the Default Gateway of the camera. The
default setting is 192.168.10.1. In most cases,
this would be your router’s IP address.

Primary/
Secondary DNS

DNS (Domain Name System) translates domain
names into IP addresses. Enter the Primary DNS
and Secondary DNS that are provided by ISP.

- PPPOE: Select this option when you use a direct connection via the
ADSL modem. You should have a PPPoE account from your Internet

service provider. Enter the User Name and Password. The camera
will get an IP address from the ISP as starting up.

NOTE Once the camera get an IP address from the ISP as starting up, it
automatically sends a notification email to you. Therefore, when
you select PPPoE as your connecting type, you have to set up the
email or DDNS configuration in advance.

-20-




B DDNS Setting

With the Dynamic DNS feature, you can assign a fixed host and
domain name to a dynamic Internet IP address. Select the Enable
option to enable this feature. Then, select the Provider from the pull-
down list and enter the required information in the Host Name, User
Name, and Password boxes. Please note that you have to sign up for
DDNS service with the service provider first.

B UPnP

The camera supports UPnP (Universal Plug and Play), which is a set of
computer network protocols that enable the device-to-device
interoperability. In addition, it supports port auto mapping function so
that you can access the camera if it is behind an NAT router or firewall.
Select the Enable option to enable this feature.

H  Bonjour

The devices with Bonjour will automatically broadcast their own
services and listen for services being offered for the use of others. So if
your Browser with Bonjour then you can find the camera on your local
network without knowing its IP address.

The Apple Safari already with Bonjour. You can download the
complete Bonjour for IE Browser from Apple's web site by visiting
http://www.apple.com/bonjour/.

B Ports Number
- HTTP Port: The default HTTP port is 80.

- RTSP Port: Configure the transmission of streaming data within the
network. The default RTSP (Real Time Streaming Protocol) port is
554,

NOTE If the camera is behind an NAT router of firewall, the suggested to
be used is from 1024 to 65535.
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Network >> IP Filter

The IP Filter setting allows the administrator of the camera to limit the
users within a certain range of IP addresses to access the camera.

Network » IP Filter

1P Filter

IP Address Range:

End

Deny IP List: + | Delete |

B Start/End IP Address

Assign a range of IP addresses that are not allowed to access the
camera by entering the Start IP address and End IP address. When you
are finished, click Add to save the range setting. You can repeat the
action to assign multiple ranges for the camera.

For example, when you enter 192.168.10.50 in Start IP Address and
192.168.10.80 in End IP Address, the user whose IP address located
within 192.168.10.50 ~ 192.168.10.80 will not be allowed to access
the camera.

H  Deny IP List

The list displays the range setting(s) of IP addresses that are not
allowed to access the camera. To clear the setting, select a range of IP
addresses from the list and click Delete.
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Network >> Wireless Setting

The camera supports WLAN while you use the wireless network. Select the
Enable option to enable this feature.

Network » Wireless Setting

Wireless

Enable E]

Network ID(SSID): Trendnetskyh Site Sunvey

Wireless Mode: @ |nfrastructure ) Ad-Hoc

Channel:

Authentication: WPAZPSK ~

Encryption: D TKIP @ AES

Pre-Shared Key: ssssssses

- Network ID (SSID}: Keep the default setting of this option to
connect the camera to any access point under the infrastructure
network mode. To connect the camera to a specified access point,
set a SSID for the camera to correspond with the access point’s ESS-
ID. To connect the camera to an Ad-Hoc wireless workgroup, set the
same wireless channel and SSID to match with the computer’s
configuration.

Click Site Survey to display the available wireless networks, so that
you can easily connect to one of the listed wireless networks.
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Enable:

il

Network ID{S5ID): TRENDnet | Site Survey

ESSID Mac Channel Mode Privacy signal
TRENDnet 00:14:d1:26:b4:34 11 Infrastructure No 23%
GBP 00:14:d1:23:be:6d 1 Infrastructure Mo 23%
2WIRESO0S 00:1b:5b:80:d7:09 1 Infrastructure Yes 7%
TrendnetSky2 00:14:d1:c0:64:19 2 Infrastructure Yes 7%
TrendnetSky2 00:0e:8e2:7d:2=2:54 5 Infrastructure Yes 26%
TRENDnet_632BRP 6 Infrastructure Yes 23%
TrendnetskyN 00:14:d1:cb:9d:=4 k] Infrastructure Yes 52%
CAMTEST 00:14:d1:62:0d:1d 10 Infrastructure Mo 31%
TrendnetskyN 00:14:d1:cb:b2:58 k] Infrastructure Yes 7%
TrendnetskyN 00:14:d1:ch:b2:be 9 Infrastructure Yes 13%

List of searching results

- Wireless Mode: Select the type of wireless communication for the
camera: Infrastructure or Ad-Hoc.

- Channel: Select the appropriate channel from the list.

- Authentication: Select the authentication method to secure the
camera from being used by unauthorized user: Open, Shared-key,
WPA-PSK, and WPA2-PSK. The following table explains the four

options:

Open The default setting of Authentication mode, which
communicates the key across the network.

Shared-key Allow communication only with other devices with
identical WEP settings.

WPA-PSK/ WPA-PSK/WPA2-PSK is specially designed for the

WPA2-PSK users who do not have access to network
authentication servers. The user has to manually
enter the starting password in their access point or
gateway, as well as in each PC on the wireless
network.

If you select Open or Shared-key as the Authentication mode, you
need to complete the following settings:
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Encryption: Select the WEP option to enable the data encryption
feature to secure the camera within the wireless network.

Format: Once you enable the Encryption feature, you need to
determine the encryption format by selecting ASCII or HEX. ASCII
format causes each character you type to be interpreted as an
eight-bit value. Hex format causes each pair of characters you
type to be interpreted as an eight-bit value in hexadecimal (base
16) notation.

Key Length: Select the WEP key length you use: 64 bits or 128 bits.
WEP Key 1/2/3/4: Enter the WEP key(s) in the following boxes.

If you select WPA-PSK or WPA2-PSK as the Authentication mode,
you need to complete the following settings:

Encryption: Select TKIP or AES. TKIP (Temporal Key Integrity
Protocol) changes the temporal key every 10,000 packets to
insure much greater security than the standard WEP security. AES
(Advanced Encryption Standard) is used to ensure the highest
degree of security and authenticity for digital information.

Pre-Shared Key: This is used to identify each other in the network.
Enter the name in the box, and this name must match the Pre-
shared key value in the remote device.
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Network >> Wireless >> WPS Setting

WPS (Wi-Fi Protected Setup) sets a new standard of Wi-Fi security,
providing a simplified secure network setup solution for the end users.
WPS can be enabled by the following two options:

1.
2.

PIN Mode
PBC Mode (or WPS button on the device, depending on hardware
design)

Netwok » Wireless » WPS Setting

PROTECTED SETUP

© PIN Mode:
PIN Code: 00629454

Registrar 10(s1D): | TRENDnet [ site Survey |

£ PBC Mode:

0 EEe

Device Status

Device Idle

PROTECTED SETUP

Press the Reset To Unconfigured button to reset the WPS
configuration of the camera.

WPS

- PIN Mode: The PIN (Personal Information Number) mode builds the
connection by entering the PIN Code directly.

a. Click the PIN Mode option.

b. Click Site Survey button to select the router (or access point)
you want to connect.

c. Click the Connect button to start WPS function of the camera.

d. You need to enter the PIN Code displayed on the camera to the
router (or access point) within 120 seconds to complete the
setup.
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- PBC Mode: The PBC (Push-Button-Configuration) mode builds the
connection by simply pressing a button on the device.
a. Click the PBC Mode option.
b. Click the Connect button to start WPS function of the camera.

TIP Instead of clicking the Connect button of Configuration Utility,

you can press the WPS button if the camera is designed with
a hardware button of WPS function.

c. You need to press the WPS button on the router (or access
point) within 120 seconds to complete the setup.
B Device Status

Display the WPS configuration of the camera.
TIP The Power LED indicates the WPS connection status by:
- blinking 3 times when the connection is built successfully.

- repeating 3 times of short-short-long blink when the connection
is failed.
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4.5 Pan/Tilt Settings
The Pan/Tilt menu allows you to configure the pan/tilt functions of the

camera.

Pan & Tilt >> Pan & Tilt Settings

AN 1T YVITESESS FUETEING taTiEr - FNaTWS mremes

] hitp/ 15216814/

Vi Fwvorites 8 Pan/Tik Winelers Nebwork Camens fi o~ B - & v Pagew Safey~-

@ TRENDNET

Localion: 20118

m Pan & Tilt » Pan & Tilt Setting
-

GCalibention

(1-20) degrees

Smart Wizard

F—
Basic

(1-20) degrees

[ Auto Patrol Sty Tme: | 1 (1-899) S4ciE)

S |
Network Startup Precst Hane | =

Fem—
Event Sarver

P —
Motion Detect

—
Event Config

Copyright © 2011 TRENDner A1 Righcs Reserved

@ Imternet | Protecied Modes Off - 0% -

- Pan/Tilt Calibration: Click Calibration to calibrate the position of the
camera lens.

- Pan Steps: Set the changing range (1~20 degrees) when you click
the Left/Right button.

- Tilt Steps: Set the changing range (1~20 degrees) when you click the
Up/Down button.
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- Auto Patrol Stay Time: Set the stay time (1~999 seconds) of each
preset positions when the camera is patrolling.

- Startup Preset: Set the position (1~8, or None) to start patrolling.

4.6 Setting up Video & Audio

The Video & Audio menu contains three sub-menus that provide the video
and audio settings for the camera.

Video & Audio >> Camera

AN 1IN VNS FeTWanG - wnaows

] hitp://192.1681 A/adminysetup.cgilpages camera HEIE

Frvortes g Pan/Tilt Wirehess Network Camirs = Bages Jafety -

SecurView Wireless N Day,/Night
@ TREnnnET Pan,/Tilt/Zoom Internet Camera
TWPA22WN

Location: 201 58

m‘ Video & Audio » Camera
| 00 Setup

Smart Wizard

Network

Pal

Image Setting

Event Server

Motion Detect

Device Info

Done i@ Internet | Protected Mode: OFf A v H10% -
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Image Setting

Brightness: Adjust the brightness level from 0 ~ 100.
Contrast: Adjust the contrast level from 0 ~ 100.
Saturation: Adjust the colors level from 0 ~ 100.

Click Default to restore the default settings of the three options
above.

Mirror: Select the Horizontal option to mirror the image
horizontally. Select the Vertical option to mirror the image vertically.

Light Frequency: Select the proper frequency according to the
camera’s location: 50Hz, 60Hz, or Outdoor.

Overlay Setting

Includes Date & Time: Select this option to display the date & time
stamp on the live view image.

Enable Opaque: Select this option to set a black background to the
displayed date & time stamp.
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Video & Audio >> Video

2N/ 11T VWITEIESS NETWOTK Lamera - Y¥INaows ANteMet Cxpiorer

£] http://192.168.1 4/admin/setup.cgilpage=video ~| B || X A <h P~

iy Favorites | (@ Pan/Tilt Wireless Network Camera M- - [ @@ v Page~ Safety~

SecurView Wireless N Day/Night
@ TREnDnET Pan/Tilt/Zoom Internet Camera
TV-IP422WN

Location:  2011/01/28 13:38:40

Video & Audio » Video
MPEG2

Video Resolution: VGA -

Smart Wizard Video Quality: Highest ~

Frame Rate: 30~ s
Basic

Network Video Resolution:

Video Quality:

Pan/Tilt

Frame Rate:
Video/Audio

@ Disable
©) 3GPP Without Audio
©) 3GPP With Audio

-
Event Server [ Roply e

PEET——
Motion Detect

< i, 3

@ Internet | Protected Mode: Off G v ®10% v

B  MPEG4

- Video Resolution: Select the desired video resolution from the
three formats: VGA, QVGA and QQVGA. The higher setting (VGA)
obtains better video quality while it uses more resource within your
network.

- Video Quality: Select the desired image quality from five levels:
Lowest, Low, Medium, High, and Highest.

- Frame Rate: Select Auto or a proper setting depending on your
network status.
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B MIJPEG

- Video Resolution: Select the desired video resolution from the
three formats: VGA, QVGA and QQVGA. The higher setting (VGA)
obtains better video quality while it uses more resource within your
network.

- Video Quality: Select the desired image quality from five levels:
Lowest, Low, Medium, High, and Highest.

- Frame Rate: Select Auto or a proper setting depending on your
network status.

NOTE The camera supports both MPEG4 and MJPEG compression. MJPEG
capture the images in JPEG format, which require higher bandwidth
to view smooth video. The administrator can control the bandwidth
of each connection well through the setting options above.

B  3GPP

The camera supports 3GPP specification. Select the Disable option to
disable this feature. Otherwise, select 3GPP Without Audio or 3GPP
With Audio to transfer the video clips without or with audio.

If you use a mobile phone that supports 3GPP, you can also view the
real-time streaming image captured by the camera on your phone
(with the default player on the phone) by entering the RTSP link:
rtsp://(IP address of the camera)/3gp.

NOTE Your mobile phone and the service provider must support 3GPP
function. Please contact your service provider when you are failed
to use this service.
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Video & Audio >> Audio

AN/ 11T ¥VITEIESS MNETWOTK Lamera - ¥¥INJows INtermeT Cxpiorer

I

2] hitp://192.168.1 8/admin/sctup.cgi?page=audio - mle|x

s Favorites | (@ Pan/Tilt Wireless Network Camera

Video & Audio » Audio
‘Camera Microphone In
—

n ‘Camera Speaker Out
Smart Wizard =

Location:

SecurView Wireless N Day/Night
@ TRE“D“ET Pan/Tilt/Zoom Internet Camera

Tv-IP422WN

2011/01/28 13:39:00

Basic

Network

Pan/Tilt

Video/Audio

< ,

b

Done @ Internet | Protected Mode: Off

Ya v WI00% <

B Camera Microphone In

Select the Enable option to enable the camera’s audio function, so
that you can receive the on-site sound and voice from the camera.

B Camera Speaker Out

Select the Enable option to enable the camera’s external speaker
function, so that the connected speaker can play the sound and voice

through the camera.

- Volume: Set the speaker’s volume.
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4.7 Event Server Configuration

The Event Server menu contains three sub-menus that allow you to get
notification via HTTP when motion triggered, upload images to FTP, send
emails that include still images, and store the images to a NAS system.

When you complete the required settings for FTP, Email, or Network
Storage, click Test to test the related configuration is correct or not. Once
the camera connects to the server successfully, click Apply.

Event Server Setting>> HTTP
HTTP Notify for Motion Trigger

Send the query parameter via an HTTP notification when an event is
triggered.

- Host Address: Enter the IP of the HTTP server

- Port Number: Enter the Port number of the HTTP server
- User Name: Enter the username of the HTTP server

- Password: Enter the password of the HTTP server

- Query: query address for the HTTP server

HTTP Notify for GPIO Trigger

- Host Address: Enter the IP of the HTTP server

- Port Number: Enter the Port number of the HTTP server
User Name: Enter the username of the HTTP server

- Password: Enter the password of the HTTP server
Query: query address for the HTTP server
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Gp Favorites gl Pan/Tit Wieslats Mitwork C.

SecurView Wireless N Day/Night
@ TREnnnET Pan,/Tilt/Zoom Internet Camera
TUPAZZWN

Location: 20110178 13:44:07

Event Server Setting » FTP

Smart Wizard

Basic

e m—
Network

AT ¥ Enable

E— & One s

Video, Audio

=
e e e
*HTTR
Rlai

Done @ Intermet | Protected Mode: Of W v Riex -

- Host Address: Enter the IP address of the target FTP server.
- Port Number: Enter the port number used for the FTP server.
- User Name: Enter the user name to login into the FTP server.
- Password: Enter the password to login into the FTP server.

- Directory Path: Enter the destination folder for uploading the
images. For example, Cameral.

- Passive Mode: Select the Enable option to enable passive mode.

- FTP Upload with: Select upload to FTP with one snapshot image or a
series image in pre-event/post-event time when event triggered.

NOTE Due to the network environment, the camera may not upload
number of images that you set.
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Event Server Setting >> Email

AN FITT PITEIESE METWONE LAMEN - YYINaOwS Imemer

o Frvorite. 8 Dan/Tie Wieless Motwerk Camars Bi = B =0 #m = Page= Salety =

@ TRENDNET o ey

Event Server Setting » Emaill

Smart Wizard

Basic

Network

Done @ Intermet | Protected Mode: Of fa - Rk -

- SMTP Server Address: Enter the mail server address. For example,
smtp.mymail.com

- Port number: Assign the SMTP port in the text box. The default
SMTP port is 25.

- Encryption connection: Select SSL or STARTTLS if your email account
uses this type of authentication. (Eg: gmail account) Leave both
unchecked if you use regular SMTP email account.

- Sender Email Address: Enter the email address of the user who will
send the email. For example, John@mymail.com.

- Authentication Mode: Select None or SMTP according to the mail
server configuration.

- Sender User Name: Enter the user name to login the mail server.
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Sender Password: Enter the password to login the mail server.

Receiver #1 Email Address: Enter the first email address of the user
who will receive the email.

Receiver #2 Email Address: Enter the second email address of the
user who will receive the email.

Send Email with: Select send Email with one snapshot image or a
series image in pre-event/post-event time when event triggered.

NOTE Due to the network environment, the camera may not send number

of images that you set.

Event Server Setting >> Network Storage

Samba Server Address: Enter the IP address of the Network Storage
server.

Share: Assign the folder on the Network Storage server to share the
files to users. For example, CameraRecord

Path: Assign a folder for this camera to upload the files on the
Network Storage server. For example, TVIP312WN. Your files will be
saved to NetworkStorage = /CameraRecord/TVIP312WN folder

User Name: Enter the user name to login into the Network Storage
server.

Password: Enter the password to login into the Network Storage server.
Split By: When the file is too large to upload smoothly, use this option
to split it by selecting File Size or Recording Time.

When Disk Full: Select Stop Recording or Recycle — Delete Oldest

Folder of File when the storage space on the Network Storage server is
full.

NOTE The video recorded files in Network Storage are enclosed by AVI

format without Audio.
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4.8 Motion Detect

The Motion Detect menu contains the command and option that allow you
to enable and set up the motion detection feature of the camera. The
camera provides two detecting areas.

To enable the detecting area, select Window 1 or 2 from the pull-down list,
and then select Enable. When the detecting area is enabled, you can use
the mouse to move the detecting area and change the area coverage.

VB INT PYITEIESE FUETWON: LAMETE - mInaows.

) bz AGLIGRIA sci

i Favorites | @ PanyTit Wineless Hetwork Camera %iov B v U s v Bagew Gafey-

@ TRENDNET

T5 Live View Motion Detaction » Datection Configuration

Network

—

Fan,/Tit

e
Event Server

——
Maotion Detect

FET———
Event Config

Tools

. L

use

Device Info

Dione ) Tezerrant | Prctected Mode: OFF a v K05 v

- Name: Assign a name to the detecting area.

- Threshold: Move the slide bar to adjust the level for detecting
motion to record video.
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NOTE Sliding the Threshold bar to the right will decrease the sensitivity of
motion detection; sliding the Threshold bar to the left will increase
the sensitivity of motion detection

4.9 Event Config

The Event Config menu contains five sub-menus that provide the
commands to configure event profiles.

Event Configuration >> General Setting

B hetp://192.068.1 4/ admin/setup.cgilpages geners - 1 | 2 QBT Live Search 2o

iy Favarites | (@ Pan/Tilt Wireless Network Camera M~ B v & v Bagev Safety~

TV-IPA22WN

Location:  2011/011

m Event Configuration » General Setting
OoSetp | General

Filenamse Frefic
SnapshotRecording Fllename Prefe

Smart Wizard

o seo(s)

Recording Intervalk:
Netwark Storage Recording Time Per Event

o sedls)
RS 10 Trigger Out intervak: {
Network GPIC Trigger Oul Per Event

e et B ]

P—
Video,/ Audio

—

Done @ Intemet | Protected Mode: OfF v HIN% -

- Snapshot/Recording Subfolder: You can assign a descriptive name
for the subfolder to save the captured image/video files. Otherwise,
leave this option blank to use the default setting.

- Network Storage Recording Time Per Event: Limit the recording
time while you are using the Network Storage solution.

- GPIO Trigger Out Retention Time Per Event: Limit the retention
time of the GPIO Trigger Out function.
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Event Configuration >> Arrange Schedule Profile

This sub-menu displays the scheduled profile(s). To customize the profile,
click Add and then enter a descriptive name for the profile in the prompt
dialog window. After entering the profile name, click OK and the profile is
added to the Schedule Profiles list. To delete the profile, select the profile
in the list and click Delete.

B INT PYFESESE MO TR LAIME - mnaces Intemet

21/ ORISR A s et i page=schedulepichile | B s | x AT Live Secech £

Favorites gl PanyTik Wireless Network Camens fi ~ B - [ & ~ Bage~ fabey~

@ TRENDNeT

Event Configuration » Arrange Schedule Profile

Schedule Profie

Wed © Thu @ Fri ) Sat

Add Copy this 1o al weekdays
Event Server
Doietn || Deiste this iom all weskdays

Mation Detact '

—
Event Config

Dene ) Intenet | Protected Mode: DI fa v Rk v

- Profile Name: Display the profile name that you select in the
Schedule Profiles list.

- Weekdays: Select the weekday(s) that you want to separately assign
in the schedule profile. The weekday that has been assigned will be
displayed with green color.

- Time List: Display the time period that you have assigned within the
selected weekday. To assign the same time period to every weekday,
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click Add this to all weekdays; click Delete this from all weekdays
to remove the selected time period from every weekday. Click
Delete to remove the selected time period.

- Start/End Time: Enter the start and end time and then click Add to
assign a time period within in the selected weekday.

Event Configuration >> Motion Detect Trigger

Select the Enable option to enable the motion detect trigger function of
the camera, so that you can set Trigger Out function or send captured
images within the detecting area to the FTP server, email receiver,
Network Storage server, or the connected USB device. You have to
configure corresponding settings, such as FTP server and email server, to
enable this feature.

F3N/ 1T WVITEIESS NETWOTK LAMEra - ¥INAowWs INTemet

£ hitp://192.168.1 &/admin/setup.cgilpage=motiontrigger

i Favorites | @ Pan/Tilt Wireless Network Camera fir ~ B ~ ) & v Pagev Safety~

SecurView Wireless N Day/Night
@ TRE“DnET Pan/Tilt/Zoom Internet Camera
TV-IP422WN

Location:  2011/01/28 13:43:07

Event Configuration » Motion Detect Trigger
T ———

(*Please set the corresponding server setting first)

Enable ]

Smart Wizard
Schedule Profile: always ~

Basic [F1 Trigger Out

[C] save Image to USB

Network
[C] Record to Network Storage

Pan/Tilt [ send Email
[] FTP Upload
Video/Audio [ HTTP Moty

Event Server ]

Motion Detect

4 i v
Done @ Internet | Protected Mode: Off fa v |]100% ~

- Schedule Profile: Select a schedule profile from the pull-down list.
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- Action: Set the Trigger Out function or select the destination of the
captured images: Save Image to USB, Record to Network, Storage,
Send Email, or FTP Upload.

Event Configuration >> Schedule Trigger

You can separately configure the schedule for trigger function of the
camera by Email, FTP, or Network Storage. Select the Enable option on
each item, and then select a Schedule Profile from the pull-down list and
set the Interval time.

VBN LIIE WWINEHE33 PRTWENE L BMEM - WIRGOWS Intemat

| e/ IRLIERA A sdeminy s stup.c qiT page= scheduletrigaes HEE

Favorites 8 Pan/Tik Wireless Network Camers -8

SecurView Wireless N Day/Night
@ TREnDnET Pan,/Tilt/ Zoom Internat Camera

TWIPZEWN
Locatioa: 20110475
Event Configuration » Schedule Trigger

Emall Schedule
Enable

Schedube Protie:

Smart Wizard
Interval:

gssK FTP Schedule

P——
Network Enabile
Schodule Profie: ahways -

Intarvak 30 secls)

Network Storage Schedube

Motion Detect

————
Event Config

A Iemet | Pretected Mode O#
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NOTE If the setting value of the Network Storage Recording Time Per
Event option in General Setting is longer than the Interval time in
Network Storage Schedule, the recorded file will be a continuous
video clip.

For example, if you set the Network Storage Recording Time Per
Event as 10 seconds and the Interval as 5 seconds, recorded file
becomes a non-stop video clip because the camera will record a
10-second video clip every 5 seconds.

Event Configuration >> GPIO Trigger

Select the Enable option to enable the GPIO trigger function of the camera,
so that you can set Trigger Out function or send captured images within
the detecting area to the FTP server, email receiver, Network Storage
server, or the connected USB device. You have to configure corresponding
settings, such as FTP server and email server, to enable this feature.

FAN 1R VEREIEES [YETAONG L AMers - YINaSWE IMEmeT

e/ 1921681 A/ v/ sebisp. g Ipage= gerotngger o | b |y | WA Love Search P o.

Favorites | g Pan/Tih Wieeless Network Camera I e v Bagev Sefetyr

Event Configuration » GPIO Trigger

GPIO Trigger

P—
Motion Detect

F——
Event Config

Dore @ Jetemes | Protected Mode: 4 v RN -
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- Schedule Profile: Select a schedule profile from the pull-down list.

- Action: Set the Trigger Out function or select the destination of the
captured images: Save Image to USB, Record to Network, Storage,
Send Email, or FTP Upload.

4.10 Tools

The Tools menu provides the commands that allow you to restart or reset
the camera. You can also backup and restore your configuration, and
upgrade the firmware for the camera.

¥ I VTS IWETWAING L M - JInaows smemer

B iz 1921680470

-8 - m v Pagew Safetyw

Ur Favontes @ PanyTilt Wireless Met

@ TRENDnET

System Tools » Tools

Factory Reset
Farctory ree willrestore e Gevice's factory Gefaul Setings

—_— Faset
Smart Wizard

P
S System Reboot

P—
Network FReboot e devce.

P — Reboot
Pan/Tilt

e
Video, Audio Configuration

"Evert Semer ) EEELEEE jgurations. Click n ballow and 53ve ha device configurations 1o your locsl harddrive

Gt 1ha backup fis
—_—
Motion Detect

Seca's configueabon Fom a backup fike.
O s
Event Config Browse_. || Restore

_
Tools

P —
usE

e,
Device Info

Browse. Update

Copyright € 2011 TRENDner. A Rights Reserved

@ Internet | Pretected Mede: OfF fa v R0k ~

B Factory Reset
Click Reset to restore all factory default settings for the camera.
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B System Reboot

Click Reboot to restart the camera just like turning the device off and
on. The camera configuration will be retained after rebooting.

B Configuration

You can save your camera configuration as a backup file on your
computer. Whenever you want to resume the original settings, you
can restore them by retrieving the backup file.

- Backup: Click Get the backup file to save the current configuration
of the camera.

- Restore: Click Browse to locate the backup file and then click
Restore.

B Update Firmware

This item displays the current firmware version. You can upgrade the
firmware for your camera once you obtained a latest version of
firmware.

- Select the firmware: Click Browse to locate the backup file and then
click Update.

NOTE Make sure to keep the camera connected to the power source
during the process of upgrading firmware. Otherwise, the camera
might be damaged because of failure of upgrading firmware.
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4.11 USB

The USB menu provides the information and controls of the connected
USB device.

3N/ 11T ¥IrEIEsS INETWOTK LaMmera ~ ¥WINaows intermnet

2] http://192.168.1 &/admin/sctup.cqi’page=ush = | &[4 | % [ £7 Live Search o~

i Favorites | @ Pan/Tilt Wireless Network Camera fir ~ B - =) d@ - Page~v Safety~

@ TREnDnET SecurView Wireless N Day/Night

Pan/Tilt/Zoom Internet Camera
TV-IP422WN

Location:  2011/01/28 13:50:34

USB » USB Setting
USB Dismount

Smart Wizard fSanibynaton

Total space: Usb not available

Free space: Usb not available

|

Network USB Setting

(© stop Recording
) Recycle - Delete Oldest Folder

Video/Audic R

Event Server

\

Pan/Tilt ‘When Disk Full:

\

\

\

Motion Detect

\

Event Config

|

[=
[72)
@

\

Device Info
aT i »

Done @ Internet | Protected Mode: Off fa v H100% v

B USB Dismount

To safely remove the connected USB device, you can press the
Unmount button for four seconds on the camera or click Dismount
from this item.

B USB Information
Display the Total space and Free space of the USB device.
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B USB Setting

- When Disk Full: Select Stop Recording or Recycle — Delete Oldest
Folder of File when the storage space on the USB device is full.

NOTE The connected USB storage device can be used to store still images
only and as your host system backup. It is not recommended to use
the USB device as your major storage device.
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4.12 Device Info

The Information menu displays the current configuration and events log of
the camera.

VAN 1T WVINEIEST TETWO K

2] hetp:/ /19216814 /sdminsetup cgitpa v | (3| 49 | x JRE Live Search P

oy Favorites 8 Pan/Til Wireless Mebwork Camens f = B - & = Pagew Safety~

@ TrRENDNET

Dvice Infa

- e
- It Loy

Ly © VY TSR A3 gl eserved

Dene @ Intermet | Protected Mode O fa = RN -

H Device Info

Display the Basic, Video & Audio, Network, and Wireless settings of
the camera.

B System Log
The Logs table displays the events log recorded by the system.
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CHAPTER 5

SECURVIEW™ PRO SOFTWARE

This chapter describes detailed instructions on using efSecurView Pro, a
customized software application with a user-friendly interface that allows
you to access your cameras. The Software can monitor and record up to 36
cameras. It also let you change some basic settings of the camera, such as
schedule profiles and motion detecting areas. The SecurView Pro also
supports audio or Pan/Tilt function.

It is recommended to use a high performance computer if you want to
connect multiple cameras simultaneously.

Platform: Microsoft® Windows® 7/Vista/XP
Hard Disk: 80GB or above
Resolution: 1024x768 or above

Hardware Requirement
The following provides the minimum hardware requirements:

1~ 8 cameras: Intel Core 2 Duo; 2GB RAM
9 ~ 32 cameras: Intel Core 2 Quad; 4GB RAM

* For Windows Vista users: please go to User Accounts and Family Safety
> User Accounts > Turn User Account Control on or off, then uncheck
the checkbox of “Use User Account Control (UAC) to help protect your
computer”. Restart your computer to validate the setting. For additional
information of User Account Control, please go to
http://www.microsoft.com/windows/products/windowsvista/features/d

etails/useraccountcontrol.mspx
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5.1 Installation

1. Insert the Installation CD-ROM into your computer’s CD-ROM
drive to initiate the Auto-Run program.

@ TReNDneT

IP Setup
SecurView Pro

User's Guide

Product Registration

SecurViiew Wireless N
Day/Night Pan/Tilt/
Zoom Internet Camera
TV-P422WN

© Copyright 2011 TRENDnet. All Fights Aeserved

2. Click the SecurView Pro from the Auto-Run menu screen.

NOTE: To use SecurView™ Pro, you must have Microsoft .NET
Framework 2.0 installed in the computer. The setup wizard will
detect it and, if the program is not installed yet, it will ask you to
install it during the process of installing SecurView™ Pro.

NOTE: Microsoft Windows Installer 3.0 or above is a required component
to install SecurView Pro. For more information of the required
component during installation, please visit the Microsoft support
Website.
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3. Then SecurView Pro Setup Wizard will appear. Click “Install”.

s Y
£ Setup - SecurView Pro =

Ready to Install
Setup is now ready to beqgin installing SecurView Pro on your computer.

Click Install to continue with the installation.

4. Wait until the program finish the installation. By default, the
destination location is C:\Program Files\TRENDnet\SecurView Pro.

- 5
F&? Setup - SecurView Pro = |I=]

Installing
Please wait while Setup installs SecurView Pro on your computer.

Extracting files...
C:\Program Files\TRENDnet\SecurView Pro\Skin\Resolution2\N_Button_r2_c2.jpg

Cancel
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5. Click “Finish” to finish the installation.

£ Setup - SecurView Pro E‘—I—]

Completing the SecurView Pro }
Setup Wizard
Setup has finished installing SecurView Pro on your

computer. The application may be launched by selecting the
installed icons.

Click Finish to exit Setup.

6. After installing the SecurView Pro, the application is
automatically installed to your computer, and creates a folder in

“ Start \Program\TRENDnet\SecurView Pro” .

TRENDnet
IPSetup
SecurView Pro
72 SecurView Pro
|5l Streaming Server
¥& Uninstall SecurView Pro -

1 Back




5.2 Using SecurView™ Pro

5.2.1 Launch the Program

To start SecurView Pro, click Start > All Programs > TRENDnet >SecurView
Pro > SecurView Pro. You can also start the program by double-click the
SecurView Pro icon on your desktop.

-

SecurView Pro

@® TRENDNET

Please enter user name and password

User name: EBlils

Password:

SecurView

On the login window, enter the User name/Password and click OK to login.
The default User name/Password is admin/admin. If you wish to save the
login information, please select Auto Login.
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5.2.2 Main Window and Features

When you start and login to SecurView Pro, the Main window will display
as below:

11/15/2010
14:50:53

Camera List

I

The Main window provides you with the information on operating the

system, as well as the control panel such as the Quick Launch buttons, and
so on.

NOTE For best result, it is higher recommended to configure resolution setting to
1024 x 768 or higher; otherwise, it cannot be displayed on the screen
when launching the program.

0 Live View Window displays the live video of the connected camera(s).
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9 Quick Launch Buttons are located below the Live View Window,
providing you with the following quick-launch functions:

Button

Function

Logout : To log out the SecurView Pro program
Close: To close the SecurView Pro program

Restore Recording Type: Restore all recording type to current
camera’s setting

All Continuous Recording: Continuous recording on all
cameras

Stop All Recording: Stop recording on all cameras

View Setting: To configure eMap settings
eMap View: To view current maps
Camera Status: Display cameras status

C)

Playback: Playback recorded files

<)

(

Schedule: Display Schedule Configuration window

©

Event Server: Setup a SMTP server

Address Book: Add/Remove email address for event
notification

Event Trigger: Setup event trigger configuration

°),

Device Setting : Set up the camera
Recording Setting: Set up the recording path

®

Account information: Setup administrator password

Version: Display software version
System Setting: Software settings
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9 Camera View Mode buttons in this area allow you to switch the
camera view mode.

Functions

Display the connected camera(s) in a single camera view
mode.

Display the connected camera(s) in a quad view mode.

Display the connected camera(s) in a 3 x 3 grid view mode.

Display the connected camera(s) in a 13-camera view mode
using a split window. The first camera is displayed as the
major view.

Display the connected camera(s) in a 17-camera view mode
using a split window. The first camera is displayed as the
major view.

Display the connected camera(s) in a N x N grid view mode,
supporting up to 36 cameras.

EIENEIENEE=IE

Display the live view of the selected camera in full screen
mode. Click ESC on the keyboard to return to Main window.

B

Automatically switch the live view of each connected
cameras in single camera view mode by 30 seconds*. Click
once to start and click again to stop.

* The auto-switch time is set as 30 seconds by default, which
can be changed by clicking the @ - System Setting and

then change the value from the pull-down list of the Auto
Switch time interval option.

9 System Information displays the system information, including the
date and time, and the available storage space of the system.

6 Live View Status provides the status of live view mode, including
Camera List and eMap.
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® Camera List displays the status of the connected cameras. If
multiple cameras are connected, you can switch to the live
view of each camera by simply selecting the camera from the

list.

® eMap allows you to select the desired camera to the view
from the map easily. Please note that you have to set up the
eMap for monitoring in advance.

@ Camera Control Buttons provides the control buttons that allow you
to control the selected camera.

Buttons

Functions

@

Talk On/Off. Click to enable/disable the speaker function
of the connected camera. This option is available only in
single camera view mode.

Listen On/Off. Click to enable/disable the microphone
function of the connected camera. This option is available
only in single camera view mode.

R

For Pan/Tilt cameras, use this control panel to set the
preset positions (up to 8 positions).

Use Navigation buttons to adjust camera position, and
then select the position number (1~8) from the Set button.
To move to the preset position, simply select the position
number (1~8) from the Go button.

Navigation Buttons (Left/Right/Up/Down/Home). If the
connected camera has pan/tilt functions, the Navigation
buttons allow you to move the camera lens position.
Clicking the Home (center) button will move the camera
lens to the assigned home position.

=  ED

The Patrol/Stop buttons are used to enable/disable the
patrol function of the camera. Click Patrol to start
patrolling through the preset positions once. Click Stop to
stop patrolling.
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5.2.3 Manage the Cameras

Before adding the cameras, please setup the recording setting first.
B Configure Recording Settings

1. Click the button and then select Record Setting.

Device Setting |

2. Default path is C:\, click Browse and select the desire
directory then click Save to complete the configuration.

To change the time interval for recording, select time from
the pull-down menu.

# Fecced Secng -

Davics > Record Softing

Basc i

Fecording Path Browsa |
r Rocord Fia B0 = Seconds Fres space - 256 GB
¥ Recycla Mode
* Piaas choose a recanding target foldar
For examps !

It the Recording Path s D Wideo |
The network camens's recording files wil be saved 1o D Wideo'Video Data'CHY

The nebwork camrs’s recording files will be saved 1o D Wideo\Video Duta\CHI?

NOTE: The system will automatically delete the oldest files (10%) when the size of
recorded files is up to 90% of the storage space.
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Add a Camera

1. Click the &) button and select Device Setting to display the
Device Setting window.

Device Setting

Record Setting

2. Click New.
5 Dewce .
Device > Device Salting
Device List '
CameraTle  Paddiess  Pod  CHE  Brand Model Recoed Type  Stream |

N

How Modify Remove
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3.

4.

Click on Device Search, all cameras that’s connected to your
network would appear.

odek P address Port  Devce Name MAL Address.

Camera § |
1P aicregy

Account
Password

Stream:

Record

Cancol Back o List

|

Select the camera you would like to add and then click Add.

Camesa Titke P address Foi G Brand Mol Recend Typs Stream
TVIP4ZWN 192 168 1.35 L] 1 TREMDnet TVIPLZN Mot Recording MPEGE
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5. The information of the camera will display on the screen.
It will auto detect the IP address/port number and display the
stream type of the camera. Please type in the correct user
name and password, then select Preview to view live image.

D > Maddy Camera TV-PAZIVN
Sating

Uodify Cameen Do Search Motion detection ares

P Wimdem

Freaen Diacenssct

Saw Canesl Bk 12 Lint

6. To setup recording style, select Yes on Record option. These
four recording types will appear. Select one of the recording
type, configure it then click Save.

Record: © No @iYes:
@ Continuously Add Schedale
) Schedule
© Motion
© Motion by Schedule | +]
© Digital Input
Save I l Cancel ] l Back to List ]

Continuously:
Record the stream video continuously
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Schedule:
Records stream video by schedule. You can setup the
schedule by click Add Schedule here.

Click on New to create a new schedule and select the time to
record. Click on Save when finish.

Schedule > Schedule Configuration
Schedule
Schedubs List

Schedube Tille S Mon Tee Wed T Fn Sat

o M UM L
{[IIIM[I_I_[III_H]'[I [II_IIIH_H[ P

Motion:

Record video by Motion Detection. Motion detection
recording required to setup a motion detection area. If you
are adding a new camera, you must save the camera
information first before setup the motion detection area.
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To use motion detection record, please enable the detection
areas first. Click on Motion detection area to setup

Satting
Medity Campn Dwice Search Maticn detwction ses
Modsl TV4ZINN
Camera Tithe VRPN Presew Window
P s (EERERES
Peat 0
Azceurt i
Password -

Strasm & MPEGL O MBES HPE

Racond Ne . Yeu

® Contirunusly 4 Scheddle
Schedule i -
Matien i
Mstien by Sehadule =
Digtallnges
Save Cancel Back 1o List

Enable motion detection windows, set up the senstivity and
click on Save.
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Motion by Schedule:
same requirement as Motion & Schedule recording.
Digital Input:

Recording triggered when there I/O port is triggered.

After all recording methods are configured, click Save to
apply the settings.

Disice = Miscily Camars TVAP4ZZWN
Sating
Modity Camera | Device Search Moticn detpcton s
Modet TV-PAZINH -
Camara Tite TPz
P pddress 192 168 138
Part ]
Account i
Password s
Strvam ® WEGH © MPEG
Rscord My . Yor
® Contincousty
Schedue
Meton
Metion by Schadula =
Digptal Input
Sma Cancal Bk ts Lint

Camera list will appear with recording type notification.

[ ——

Patwn Pt OW B [ Buaed Trpm Py
wmwin ® 1 SO TeRamen [ [
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NOTE

“y,n

8. Once you added all the cameras, click the close button “x” on
the Device Setting windows to return to the main windows.
The cameras will display here.

Camera Tl
TVPTIOWN
THRIZIW
TVPAOW
VP10
VP25

P address
192 168.1.77

162 168.1.193
192 1681187
192 1681213
192 1681182

80
9112
o3
a1y
o5

1
2

3
a
5

Brand
TRENDInet
TREMDIat
TRENDIE
TRENDI2t
TRENDIet

i -
Device > Devics Setting |
Device List

Poil  CHY

L
TV#R121W ot Recording WIPEG
TviP252P Not Recording MPEGH

Divx/Xvid codec is required for viewing the image of camera. If the image
cannot be displayed in the Live View/Preview window normally, click the
following path to download and install the required component:
http://download.divx.com/divx/DivXinstaller.exe
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Edit / Delete a Camera

1. To edit a camera: From the Device Setting window, highlight
the camera you would like to edit then click on Modify button.

2. To delete a camera: select the desired one and then click
Remove. Click Yes to confirm.
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B View Camera Image

Since you have added camera(s) to the system, the image of the

selected camera(s) will be displayed on the Live View Window
automatically. You can view a maximum of 36 cameras

simultaneously. Additionally, you can select one-camera or other

view mode to display the video from the Camera View Mode

buttons.

For example, if you use only one camera, select single camera

view mode (

), and the Live View Window will display the view
as below. You can select the other modes according to your need.

The Information icon ( n ) on the top-right corner of the window

provides you with the options to connect/disconnect the camera,

select a camera to be displayed in the window, capture a still

image of the camera live video, or switch to eMap mode. Click the

Information icon to pop up the shortcut menu and select the

desired option.
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B Playback the Recorded Files

1. Click the E button to display the Playback window.

2. Onthe Playback window, select the camera and setup the
begin/end date and begin/end time, then click Search. The
search result will be displayed in the Record File list.

{ Paypacc -
Playback f
* Ploasa download the MPEGA codsc, i I s not yst Installod 0n your system ioad codec
Single Channel
Search
Canora Bogin Dafte’ 11182010 - BeginTime: 5504 pu
| EDEIOMKIIBBATT) =] EndDete 11162010 G- EndTemo:  15224PW




3. To playback the video clip, select the desired file and click
Play.

T L.
)
Feyback * Ploasa dowdicad o MPEG4 codec, if # is nof yet installod on your sysiem, Tioad o
Single Channel
Search
Camacn ) Begm Date: nnsamo O-  Begn Time: y47.02 P
| VIVIPTIOWNISZ 108 1.TT) | EndDale 11na2010 -  EndTme:  14702PM
Search
Recond Fie Playback

C ivideo DAt CHY@DTIM 1BCHT_2010.1" o
C ivideo Data\CHYSOI0M1BICHT_2000.1

D CHYQOVRI BT 2000 1 |

10T il | |

e A0 1 i

CaCHI U TG 2000 1 |
CH HBCRT 20

ACHYEOHTBAChT 201 N

: BCht_20 )

A
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5.2.4 eMap Setup & Camera Status

B Manage eMap

Click the button and select View Setting to manage eMap.

wiew Setling

ehap View

| Camera Status
.8

eMap refers to the geography and device scope in the SecurView Pro,
which visually presents the devices in your security system. It uses a

background of the area (e.g. a picture or a map) as the interface for
monitoring.

To add an eMap

1. Onthe View Setting window, click New.

i View Seting o

Viaw > Viirw Semng

eMap l

ollag List
aMap Hame image

Moty
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2. Enter an eMap name.

T com——————
View > View Sefiing

wdinp List

eMap Name

edlap Informaticn

P

Click Browse to select a Picture File from your computer. Picture will
display in the Preview window.
Wiew

View > Viaw Satting

=
whtap List

| eMap Name Image

olap nformation
oMisp N
Home:

Image File:

C WsersiMichede Desktop New fodor ’
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View > Viaw Satiing

Click Save and click OK to apply the settings
C AR R

ehap

ahtap List

eMap Name:

imags

Clsers\Michebe Deskiop New folder (2)ehta

eMap Information

‘eMap Name:

Image Fila:

CilllsersMichele Desktop Hew ol

Save

Click Camera Location to assign the camera location.
O S —— S
View > View Setting

[ eag |

eMap List

eMapName  Image
Hormi

Mg Infomation
alap Name:
Home

Image Fia:

c
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6. The following screen appears.

* Selecl o camera from the camern st and then chck on B desined camera posion on the map b place B co
* Chck on e e map b 1 ecom the g

[

7. Select the camera from the list and then click the position on the map.

The camera icon ﬁwill be displayed on map.

- Seecta trom and then chck on 0 place the cof
" Chck on e ciameTa icon on B ma o mag.
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8. Click Save when complete.

* Click 0 h CAMaEA ICON 0N tha MAG 10 remov if fram B map.

[_sme |

" Soloct 8 camora Inom P camora ksl and e chok on [ desared camors posibon on T map o place e co

[ e ]

To modify/remove an eMap

1. To edit the eMap: In the eMap List, select the map name from eMap

list, and click Modify.

The map’s information will display on the preview windows. After
changes the setting information, click Save to save the setting.

g L

MN—E

e sedormation
‘wbdap Nama
Home

Imaga Fila:
G Wservbachbe Deskop e fokior | Browse | B

[ 42 e - ——
Virw > View Setig |
wdap |
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2. To delete the eMap: In the eMap List, select the desired one and
click Remove. The selected map will be removed from the list.

w2 View Setting —
| View > View Sefting - |
|| eMap ’
ahdap List
eMap Name Image
New
Modsty
R
|
)
|
|
Browse i
|
| - =
' Save Cancel

B View eMap

a. Click the button and select eMap View.

Wigw Setting
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b. Select the map from the eMap Name list.
,-

SecurView
PRO

B Camera Status Click the camera icon %, the camera Live Monitor
window will display live image on that camera.

SecurView
PRO




5.2.5 System Info

B Account

Click the @ System button and select Account to change the
administrator password of the system.

Version
System Setting

Enter the Current password, and then enter the new password
twice (in the Type new password and Retype password boxes).
Then click Save.

- B— — ER)
System > Account Satting ]

Administrator

Current password
Type new password: I

Relype password.

Save Cancel

=




B Version

Click the System button and select Version to view the
current firmware version of the system.

—
-

System > Varsion

SecurView Pro
Version XXX

Last Update:  xx/xx/xxxx

‘Warning: This computer program is protected by copyright law and
freaties. | dh or of this

program, or any portion of it or the use with a registration key without the
explicit permission may result in severe criminal and civil penalties. and will
be prosecuted to the maximum extent possible under law.

B System Setting

Click the System button and select System Setting. Auto Scan
period can be set from 30 seconds to 100 seconds.

System > System Setling

Aulo Scan time interval. (30 = Seconds

Start the software when windows star

Auto login
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5.2.6 Event Settings

B Setting up Event Server

Click the @ button and select Event Server to configure the
SMTP settings for email notification use.

Address Book

Event Trigger

[(65, £vens s

Event > Event Server

SMTP

+ Enabla SMTP

SMTP Servar Addn majlserver com
Sender Email Addr johni@maikserver com
Authentication Mod) None @ SMTE

Sender User Name jonn
Sender Password: sessssssssss

Port Number: 25

S5L

S _. Cancel Mlm
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Select the Enable SMTP option and configure the following
information correctly to start the email feature.

® SMTP Server Address: Enter the mail server address.
For example, mymail.com or smtp.gmail.com or
smtp.live.com

® Sender Email Address: Enter the email address of the user
who will send the email. For example, John@mailserver.com.

® Authentication Mode: Select None or SMTP according to the
mail server configuration.

® Sender User Name: Enter the user name to login the mail
server.

Sender Password: Enter the password to login the mail server.

Port Number: Enter the port number used for the email
server.

® SSL: If the mail server requires an encrypted connection, you
should check the SSL option. For example, gmail users, please
select this option.

When completed, click Save and then select OK. The system will
automatically start the Event Service.

TIP The status of Event Service is indicated by the [*# icon in the system bar.
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B Sending Notification to the User

Click the @ button and select Address Book to assign the user to
the Address Book of the camera. The user will receive a real-time
notification from the system while triggering out.

Event Server
Address Book

Event Trigger

—
| fdaess -
| Event > Address Book
Address Book List
List | Name Email
Jaohn lohnihmailsener com
I New
Modity
Rz
| |

Address Book Information

Name: Mary

Emai maryi@hotmail com

1. On the Address Book window, click New.

2. Inthe Address Book Information field, enter the Name and
Email of the user.

3. When completed, click Save. The user will be displayed in the
Address Book List.
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4, To edit the user: In the Address Book List, select the desired
user and click Modify. The user’s information will be
displayed, where you can change the user’s information and
then click Save when completed.

5. To delete the user: In the Address Book List, select the
desired user and click Remove. The selected user will be
removed from the list.

B Configuring Event Trigger

Click the @ button and select Event Trigger to configure the
trigger out function of the camera.

| Ewent Server

Address Book

Event Trigger

0.0.C

i Event Tngge,
| Evort > Evort Triggor

Camara List

TVIP 1921681
2 TWPL 1921881
| |3 TviPa 1921681
| 4 TVIPY 1921681
5 TwWPz 1921881

C_ Name  IPaddess  Pod

80
915
918
a1
9%

Trigger Seming

SMTP Address Book List
Hame

Subyect
Missage

Play Sound

ohlap Popar

Email

Browse Fost

Cancel

Add Address Book
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1. Onthe Event Trigger window, select the desired camera from
the Camera List.

2. Do one of the following:

® SMTP: Select this option and enter the Subject and
Message, the system will send an email message to the
selected user(s) in the Address Book List.

® Play Sound: Select this option select a sound file from the
computer, so that the system will alarm by the sound
while triggering out.

® eMap Popup: Select this option and select the eMap
profile from the pull-down menu. The camera view of the
eMap will be displayed while triggering out.

5.2.7 Close Program

When you have finished operating, click the @ button and select Logout
to logout the system or Close to exit the program.

Logout

Close
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CHAPTER 6

How to access the camera behind a Router

You can either setup the Dynamic DNS connection via camera itself or your
home router. An account from any of the listed DDNS providers is required
prior to this operation.

6.1 Configure DDNS on your Camera

1. Goto Camera’s DDNS Setting page, click Enable to activate
the feature. Then select a DDNS provider from the list.

DDNS Setting: Enable
Provider: www.dyndns.com &
d
Host Name: members_easydns.com
User Name- web easydns.com

- www.EuroDynDNS.org
Www_no-ip.com

Password:
www_ovh com

www regfish com

2. Enter your DDNS'’s the Host Name, User Name and Password.

DDNS Setting: Enable
Provider www_dyndns_com -
Host Name trendnet.dyndns.org
User Name: trendnet
Password ssssseseseseeee
UPnP: Enable
Ports Number:
HTTP Port 9000 (default: 80)
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In the Port Number section, assign an HTTP port of the
camera. The default HTTP Port on the camera is 80. The
example shows above is using port number 9000.

Open another web browser and go to your Router’s Web
Configuration page. (In the example, TRENDnet’s TEW-651BR
Wireless N router is used)

@ TRENDNET 150Mbps Wireless N Home Router

TEW-651BR
ain
Wireless
Status ) Enable @ Disabled
o Name
uutmg
Protocol
Rccess

« Filter

Virtual Server

Private Port

+ Virtual Server Public Port

+ Special AP LAN Server|

S e
D
anagement

Tools

Wizard

Name Protocol

Virtual Server FTP TCP 2121

Virtual Server HTTP TCP 80/80

Virtual Server HTTPS TCP 443/443

Virtual Server DNS UDP 53i53

Virtual Server SMTP TCP 25125

Virtual Server POP2 TCP 110i110

Virtual Server Telnet TCP 23/23

PPTP TCP 17231723

Netieeting TCP 17201720

Copyright © 2009 TRENDnet. All Aights Reserved.

Go to Virtual Server* section and create a new entry.

Enable: Click Enable
Name: Enter the application name (eg. CameraName)
Protocol: Select TCP
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Private Port: The HTTP port that you assign on your Camera.
port used on remote side to access to your

Public Port: The
Camera.

LAN Server: The local IP address of your Camera.

Virtual Server

Enable

Q' Enable Disabled

Name

IP Camera

Protocol

TCP -

Private Port

9000

Public Port

9000

LAN Server

192.168.1.101

Add Upd

Then click Add to add the application.

* Please refer to your router’s user’s manual for detail Virtual
Server setting. Some router might use Port Forwarding or
Special applications for this function. The setup steps should

be very similar.

Name Protocol LAN Server
Virtual Server FTP TCP 2121 0000
Virtual Sarver HTTE TCP B0/80 0.0.00
Virtual Server HTTPS TCP 4431443 0000
Wirtual Server DNS UDP 5353 0000
Virtual Server SMTP TCP 2525 0000
Virtual Server POP3 TCP 1101110 0000
Virtual Server Teinet TCP 2323 0000
PPTP TCP 17231723 0000
NetMeeting TCP 17201720 0.0.00
IP Camera TCP 9000:9000 192.168.1.101
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6. Open another web browser and enter your DDNS domain and
camera’s port number.

http://yourDomainName:PortNumber

€ New Tab - Windows Internet Explorer

(. )() @] nttpy/strendnetdyndns.org:9000]

7. Camera’s login page will appear.

6.2 Configure DDNS on your router

1. Goto Camera’s DDNS - Ports Number section, assign a
HTTP port for your camera and click Apply.

DDNS Setting: Enable
Provider: www dyndns com v
Host Name:
User Name:
Password:
UPnP: Enzble
Ports Number: HTTP Port: 90001 | (default: 80)

2. Login to your router’s web configuration page.

-06 -



3. Find the Dynamic DNS configuration section.

@ TRENDNET 150Mbps Wireless N Home Router
TEW-651BR
amn
Dynamic DNS et

« LAN & DHCP Server

- WAN .
DDNS Enabled @ Disabled

+ Password
+ Time Server Address | DynDns.com +

+ Dynamic DNS e

[ —
Wireless

User Name

—
Status

Duting

Access

Password

Management

Tools
Wizard

Copyright © 2008 TRENDnet. All Rights Reserved.

4. Enable DDNS, fill out the following information and then click
Apply.

Dynamic DNS

DDNS | @ Enabled © ' Disabled

Server Address | DynDns.com ~

Host Name | trendnet.dyndns.org

trendnet

User Name
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8. Go to Virtual Server* section and create a new entry.
Enable: Click Enable
Name: Enter the application name (eg. CameraName)
Protocol: Select TCP
Private Port: The HTTP port that you assign on your Camera.
Public Port: The port used on remote side to access to your

Camera.
LAN Server: The local IP address of your Camera.
Virtual Server |

Enable| @ Enable Disabled

Name| IP Camera

Protocol| TCP ~

Private Port | 9000

Public Port | $000
LAN Server| 192.168.1.101

Click Add to add the application.

* Please refer to your router’s user’s manual for detail Virtual
Server setting. Some router might use Port Forwarding or
Special applications for this function. The setup steps should
be very similar.

9. Open another web browser and enter your DDNS domain and
camera’s port number.
http://yourDomainName:PortNumber
€ New Tab - Windows Internet Explorer

10. The camera login page will appear.

a h‘rtp:fftrendnet.dyndns.org:QUUDI
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APPENDIX

A.1 Specification

Camera

General

Sensor: 1/4” color CMOS sensor
Resolution: 640 x 480 pixels

Board Lens

Focal Length: 4.0mm

Aperture (F/No): F1.8

IR LED with light sensor control
Minimum illumination: 0 Lux
Diagonal viewing angle: 64 degree

Pan & Tilt

Pan: +165~-165 degree
Tilt: +90 ~-15 degree
Preset positions: 8 positions

Image & Video

Compression: MPEG-4/MJPEG dual streaming

Exposure/white balance/Gain Control : automatic

Resolution: up to 30ps for VGA (640x480), 30fps for QVGA (320x240),
30fps for QQVGA (160x120)

Audio

Audio in: internal omni-directional microphone
Sensitivity: -48dB +/- 3dB

Frequency response: 50 ~ 16000Hz

Audio out: external output to active speaker (mono)
Echo Cancellation: hardware voice processor

Audio codec: PCM/AMR

Hardware

Network

IEEE 802.3u 10/100Mbps Fast Ethernet, Auto-MDIX

LED

Power, Link

Reset Button

Restore to factory default

WPS Button

Push button for Wi-Fi Protected Setup

Power
Consumption

10 watts max.

Power

12 V DC, 1.5 A external power adapter (3.5 mm plug)

Dimension

115x 110 x 105 mm (4.53 x 4.33 x 4.13 in)

Weight

360 g (12.6 0z)
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Temperature Operating: 0°C ~ 45°C (32°F ~ 113°F)
Storage: -15°C ~ 60°C (5°F ~ 140°F)
Humidity Max. 90% (non-condensing)

Certifications

CE, FCC

Requirement

Management Internet Explorer 6.0 or above
Interface
To Run Windows 7 (32/64 bit), Vista (32/64 bit), XP (32/64 bit)

SecurView Pro

SecurView Pro

Channel: supports up to 32 cameras
Record/Playback/Motion Detection

Network TCP/IP, UDP, ICMP, DHCP, NTP, DNS, DDNS, SMTP, FTP, HTTP,
Protocols Samba, PPPoE, UPnP, Bonjour, RTP, RTSP, RTCP
Wireless
Standard Based on |IEEE 802.11n technology
IEEE 802.11g/b compliant
Frequency 2.4~ 2.4835GHz
Antenna 1 x 2dBi dipole antenna (Reverse-SMA connector)
Data Rate 802.11n: up to 150Mbps

(auto fallback)

802.11g: up to 54Mbps
802.11b: up to 11Mbps

Security

64/128-bit WEP, WPA/WPA2-PSK

Output Power

802.11n: 15 + 1 dBm
802.11b: 15 + 1 dBm
802.11g: 18 + 1 dBm

Receiving 802.11n HT20: -67dBm
Sensitivity 802.11n HT40: -64dBm

802.11g: -70dBm

802.11b: -87dBm
Channel 1~11 (FCC), 1~13 (ETSI)
Management
Remote Remote management supported

Backup / Restore

Save/retrieve configuration files

Settings

Image

Brightness, sharpness, saturation, flip, mirror (horizontal/vertical)
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Video

Encoding type:

Resolution: 640 x 480, 320 x 240, 160 x 120
Frame rate: 1~ 30 fps

Compression: 5 levels

Recording

Recording type: continuous, schedule or motion detection with
software

Multi-Profile

3 profiles simultaneously

Port Settings

HTTP port: 80 (default)

Digital Zoom 3x

Dynamic DNS Yes

Time Synchronize with NTP server or set time/date manually
SMTP SMTP mail supported up to 2 accounts with software
System Log 100 entries (max.)
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A.2 GPIO Terminal Application

Typically used in association with programming scripts for developing
applications for motion detection, event triggering, alarm notification via
e-mail, and a variety of external control functions. The GPIO connectors
are located on the rear panel of the camera, which provide the interface of
connecting the sensor device (IN) and controlled device (OUT).

Connector Pin Assignment

PIN SPECIFICATION

IN Active High voltage 9~40V DC;
Dropout-out voltage 0V DC

ouT Close circuit current 70mA AC or 100mA DC maximum, Output
resistance 30 Ohm;

Open circuit voltage 240V AC or 350V DC maximum

Interface Schematic

Sensor device

Controlled device

]
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A.3 Glossary of Terms

NUMBERS
10BASE-T

100BASE-TX

ADPCM

AMR

Applet

ASCII

ARP

AVI

BOOTP

(@]

10BASE-T is Ethernet over UTP Category lll, IV, or V
unshielded twisted-pair media.

The two-pair twisted-media implementation of 100BASE-T is
called 100BASE-TX.

Adaptive Differential Pulse Code Modulation, a new
technology improved from PCM, which encodes analog
sounds to digital form.

AMR (Adaptive Multi-Rate) is an audio data compression
scheme optimized for speech coding, which is adopted as the
standard speech codec by 3GPP.

Applets are small Java programs that can be embedded in an
HTML page. The rule at the moment is that an applet can only
make an Internet connection to the computer form that the
applet was sent.

American Standard Code For Information Interchange, it is the
standard method for encoding characters as 8-bit sequences
of binary numbers, allowing a maximum of 256 characters.

Address Resolution Protocol. ARP is a protocol that resides at
the TCP/IP Internet layer that delivers data on the same
network by translating an IP address to a physical address.

Audio Video Interleave, it is a Windows platform audio and
video file type, a common format for small movies and videos.

Bootstrap Protocol is an Internet protocol that can
automatically configure a network device in a diskless
workstation to give its own IP address.
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Communication

Connection

DHCP

DNS

E

Communication has four components: sender, receiver,
message, and medium. In networks, devices and application
tasks and processes communicate messages to each other
over media. They represent the sender and receivers. The
data they send is the message. The cabling or transmission
method they use is the medium.

In networking, two devices establish a connection to
communicate with each other.

Developed by Microsoft, DHCP (Dynamic Host Configuration
Protocol) is a protocol for assigning dynamic IP addresses to
devices on a network. With dynamic addressing, a device can
have a different IP address every time it connects to the
network. In some systems, the device's IP address can even
change while it is still connected. It also supports a mix of
static and dynamic IP addresses. This simplifies the task for
network administrators because the software keeps track of
IP addresses rather than requiring an administrator to
manage the task. A new computer can be added to a network
without the hassle of manually assigning it a unique IP
address. DHCP allows the specification for the service
provided by a router, gateway, or other network device that
automatically assigns an IP address to any device that
requests one.

Domain Name System is an Internet service that translates
domain names into IP addresses. Since domain names are
alphabetic, they're easier to remember. The Internet
however, is really based on IP addresses every time you use a
domain name the DNS will translate the name into the
corresponding IP address. For example, the domain name
www.network_camera.com might translate to 192.167.222.8.

Enterprise network An enterprise network consists of collections of networks
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Ethernet

F

Fast Ethernet

Firewall

G

Gateway

Group

IT

HEX

connected to each other over a geographically dispersed area.
The enterprise network serves the needs of a widely
distributed company and operates the company’s mission-
critical applications.

The most popular LAN communication technology. There are
a variety of types of Ethernet, including 10Mbps (traditional
Ethernet), 100Mbps (Fast Ethernet), and 1,000Mbps (Gigabit
Ethernet). Most Ethernet networks use Category 5 cabling to
carry information, in the form of electrical signals, between
devices. Ethernet is an implementation of CSMA/CD that
operates in a bus or star topology.

Fast Ethernet, also called 100BASE-T, operates at 10 or
100Mbps per second over UTP, STP, or fiber-optic media.

Firewall is considered the first line of defense in protecting
private information. For better security, data can be
encrypted. A system designed to prevent unauthorized access
to or from a private network. Firewalls are frequently used to
prevent unauthorized Internet users from accessing private
networks connected to the Internet, especially Intranets all
messages entering or leaving the intranet pass through the
firewall, which examines each message and blocks those that
do not meet the specified security criteria.

A gateway links computers that use different data formats
together.

Groups consist of several user machines that have similar
characteristics such as being in the same department.

Short for hexadecimal refers to the base-16 number system,
which consists of 16 unique symbols: the numbers 0 to 9 and
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Intranet

Internet

Internet address

IP address

ISP

the letters A to F. For example, the decimal number 15 is
represented as F in the hexadecimal numbering system. The
hexadecimal system is useful because it can represent every
byte (8 bits) as two consecutive hexadecimal digits. It is easier
for humans to read hexadecimal numbers than binary
numbers.

This is a private network, inside an organization or company
that uses the same software you will find on the public
Internet. The only difference is that an Intranet is used for
internal usage only.

The Internet is a globally linked system of computers that are
logically connected based on the Internet Protocol (IP). The
Internet provides different ways to access private and public
information worldwide.

To participate in Internet communications and on Internet
Protocol-based networks, a node must have an Internet
address that identifies it to the other nodes. All Internet
addresses are IP addresses

Internet Protocol is the standard that describes the layout of
the basic unit of information on the Internet (the packet) and
also details the numerical addressing format used to route the
information. Your Internet service provider controls the IP
address of any device it connects to the Internet. The IP
addresses in your network must conform to IP addressing
rules. In smaller LANs, most people will allow the DHCP
function of a router or gateway to assign the IP addresses on
internal networks.

IP address is a 32-binary digit number that identifies each
sender or receiver of information that is sent in packets across
the Internet. For example 80.80.80.69 is an IP address. When
you “call” that number, using any connection methods, you
get connected to the computer that “owns” that IP address.

ISP (Internet Service Provider) is a company that maintains a

-106 -



JAVA

LAN

MIJPEG

MPEG4

12

NAT

network that is linked to the Internet by way of a dedicated
communication line. An ISP offers the use of its dedicated
communication lines to companies or individuals who can’t
afford the high monthly cost for a direct connection.

Java is a programming language that is specially designed for
writing programs that can be safely downloaded to your
computer through the Internet without the fear of viruses. It
is an object-oriented multi-thread programming best for
creating applets and applications for the Internet, Intranet
and other complex, distributed network.

Local Area Network a computer network that spans a
relatively small area sharing common resources. Most LANs
are confined to a single building or group of buildings.

MJPEG (Motion JPEG) composes a moving image by storing
each frame of a moving picture sequence in JPEG
compression, and then decompressing and displaying each
frame at rapid speed to show the moving picture.

MPEG4 is designed to enable transmission and reception of
high-quality audio and video over the Internet and next-
generation mobile telephones.

Network Address Translator generally applied by a router that
makes many different IP addresses on an internal network
appear to the Internet as a single address. For routing
messages properly within your network, each device requires
a unique IP address. But the addresses may not be valid
outside your network. NAT solves the problem. When devices
within your network request information from the Internet,
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Network

NWay Protocol

I°

PCM

PING

PPPOE

Protocol

the requests are forwarded to the Internet under the router's
IP address. NAT distributes the responses to the proper IP
addresses within your network.

A network consists of a collection of two or more devices,

people, or components that communicate with each other
over physical or virtual media. The most common types of
network are:

LAN — (local area network): Computers are in close distance to
one another. They are usually in the same office space, room,
or building.

WAN - (wide area network): The computers are in different
geographic locations and are connected by telephone lines or
radio waves.

A network protocol that can automatically negotiate the
highest possible transmission speed between two devices.

PCM (Pulse Code Modulation) is a technique for converting
analog audio signals into digital form for transmission.

Packet Internet Groper, a utility used to determine whether a
specific IP address is accessible. It functions by sending a
packet to the specified address and waits for a reply. It is
primarily used to troubleshoot Internet connections.

Point-to-Point Protocol over Ethernet. PPPoE is a specification
for connecting the users on an Ethernet to the Internet
through a common broadband medium, such as DSL or cable
modem. All the users over the Ethernet share a common
connection.

Communication on the network is governed by sets of rules
called protocols. Protocols provide the guidelines devices use
to communicate with each other, and thus they have different
functions. Some protocols are responsible for formatting and
presenting and presenting data that will be transferred from
file server memory to the file server’s net work adapter
Others are responsible for filtering information between
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R
RJ-45

Router

RTP

RTSP

)

Server

SIP

networks and forwarding data to its destination. Still other
protocols dictate how data is transferred across the medium,
and how servers respond to workstation requests and vice
versa. Common network protocols responsible for the
presentation and formatting of data for a network operating
system are the Internetwork Packet Exchange (IPX) protocol
or the Internet Protocol (IP). Protocols that dictate the format
of data for transferors the medium include token-passing and
Carrier Sense Multiple Access with Collision Detection
(CSMA/CD), implemented as token-ring, ARCNET, FDDI, or
Ethernet. The Router Information Protocol (RIP),a part of the
Transmission Control Protocol/Internet Protocol (TCP/IP)
suite, forwards packets from one network to another using
the same network protocol.

RJ-45 connector is used for Ethernet cable connections.

A router is the network software or hardware entity charged
with routing packets between networks.

RTP (Real-time Transport Protocol) is a data transfer protocol
defined to deliver live media to the clients at the same time,
which defines the transmission of video and audio files in real
time for Internet applications.

RTSP (Real-time Streaming Protocol) is the standard used to
transmit stored media to the client(s) at the same time, which
provides client controls for random access to the content
stream.

It is a simple computer that provides resources, such as files
or other information.

SIP (Session Initiated Protocol) is a standard protocol that
delivers the real-time communication for Voice over IP (VolP),
which establishes sessions for features such as audio and
video conferencing.
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SMTP
SNMP

Station

Subnet mask

T

(TCP/IP)

Transceiver

Ic

ubDP

User Name

Utility
UTP

The Simple Mail Transfer Protocol is used for Internet mail.

Simple Network Management Protocol. SNMP was designed
to provide a common foundation for managing network
devices.

In LANSs, a station consists of a device that can communicate
data on the network. In FDDI, a station includes both physical
nodes and addressable logical devices. Workstations, single-
attach stations, dual-attach stations, and concentrators are
FDDI stations.

In TCP/IP, the bits used to create the subnet are called the
subnet mask.

Transmission Control Protocol/Internet Protocol is a widely
used transport protocol that connects diverse computers of
various transmission methods. It was developed y the
Department of Defense to connect different computer types
and led to the development of the Internet.

A transceiver joins two network segments together.
Transceivers can also be used to join a segment that uses one
medium to a segment that uses a different medium. On a
10BASE-5 network, the transceiver connects the network
adapter or other network device to the medium. Transceivers
also can be used on 10BASE-2 or 10BASE-T networks to attach
devices with AUI ports.

The User Datagram Protocol is a connectionless protocol that
resides above IP in the TCP/IP suite

The USERNAME is the unique name assigned to each person
who has access to the LAN.

It is a program that performs a specific task.
Unshielded twisted-pair. UTP is a form of cable used by all
access methods. It consists of several pairs of wires enclosed
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1=

WEP

Windows

WPA

WPA2

in an unshielded sheath.

Wide-Area Network. A wide-area network consists of groups
of interconnected computers that are separated by a wide
distance and communicate with each other via common
carrier telecommunication techniques.

WEP is widely used as the basic security protocol in Wi-Fi
networks, which secures data transmissions using 64-bit or
128-bit encryption.

Windows is a graphical user interface for workstations that
use DOS.

WPA (Wi-Fi Protected Access ) is used to improve the security
of Wi-Fi networks, replacing the current WEP standard. It uses
its own encryption, Temporal Key Integrity Protocol (TKIP), to

secure data during transmission.

Wi-Fi Protected Access 2, the latest security specification that
provides greater data protection and network access control
for Wi-Fi networks. WPA2 uses the government-grade AES
encryption algorithm and IEEE 802.1X-based authentication,
which are required to secure large corporate networks.
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Limited Warranty

TRENDnet warrants its products against defects in material and
workmanship, under normal use and service, for the following
lengths of time from the date of purchase.

TV-IP422WN - 3 Years Warranty

AC/DC Power Adapter, Cooling Fan, and Power Supply carry 1 year
warranty.

If a product does not operate as warranted during the applicable
warranty period, TRENDnet shall reserve the right, at its expense, to
repair or replace the defective product or part and deliver an
equivalent product or part to the customer. The repair/replacement
unit’s warranty continues from the original date of purchase. All
products that are replaced become the property of TRENDnet.
Replacement products may be new or reconditioned. TRENDnet
does not issue refunds or credit. Please contact the point-of-
purchase for their return policies.

TRENDnet shall not be responsible for any software, firmware,
information, or memory data of customer contained in, stored on,
or integrated with any products returned to TRENDnet pursuant to
any warranty.

There are no user serviceable parts inside the product. Do not
remove or attempt to service the product by any unauthorized
service center. This warranty is voided if (i) the product has been
modified or repaired by any unauthorized service center, (ii) the
product was subject to accident, abuse, or improper use (iii) the
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product was subject to conditions more severe than those specified
in the manual.

Warranty service may be obtained by contacting TRENDnet within
the applicable warranty period and providing a copy of the dated
proof of the purchase. Upon proper submission of required
documentation a Return Material Authorization (RMA) number will
be issued. An RMA number is required in order to initiate warranty
service support for all TRENDnet products. Products that are sent to
TRENDnet for RMA service must have the RMA number marked on
the outside of return packages and sent to TRENDnet prepaid,
insured and packaged appropriately for safe shipment. Customers
shipping from outside of the USA and Canada are responsible for
return shipping fees. Customers shipping from outside of the USA
are responsible for custom charges, including but not limited to,
duty, tax, and other fees.

WARRANTIES EXCLUSIVE: IF THE TRENDNET PRODUCT DOES NOT
OPERATE AS WARRANTED ABOVE, THE CUSTOMER’S SOLE REMEDY
SHALL BE, AT TRENDNET’S OPTION, REPAIR OR REPLACE. THE
FOREGOING WARRANTIES AND REMEDIES ARE EXCLUSIVE AND ARE
IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED OR IMPLIED,
EITHER IN FACT OR BY OPERATION OF LAW, STATUTORY OR
OTHERWISE, INCLUDING WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. TRENDNET NEITHER
ASSUMES NOR AUTHORIZES ANY OTHER PERSON TO ASSUME FOR
IT ANY OTHER LIABILITY IN CONNECTION WITH THE SALE,
INSTALLATION MAINTENANCE OR USE OF TRENDNET’S PRODUCTS.

TRENDNET SHALL NOT BE LIABLE UNDER THIS WARRANTY IF ITS
TESTING AND EXAMINATION DISCLOSE THAT THE ALLEGED DEFECT
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IN THE PRODUCT DOES NOT EXIST OR WAS CAUSED BY
CUSTOMER’S OR ANY THIRD PERSON’S MISUSE, NEGLECT,
IMPROPER INSTALLATION OR TESTING, UNAUTHORIZED ATTEMPTS
TO REPAIR OR MODIFY, OR ANY OTHER CAUSE BEYOND THE RANGE
OF THE INTENDED USE, OR BY ACCIDENT, FIRE, LIGHTNING, OR
OTHER HAZARD.

LIMITATION OF LIABILITY: TO THE FULL EXTENT ALLOWED BY LAW
TRENDNET ALSO EXCLUDES FOR ITSELF AND ITS SUPPLIERS ANY
LIABILITY, WHETHER BASED IN CONTRACT OR TORT (INCLUDING
NEGLIGENCE), FOR INCIDENTAL, CONSEQUENTIAL, INDIRECT,
SPECIAL, OR PUNITIVE DAMAGES OF ANY KIND, OR FOR LOSS OF
REVENUE OR PROFITS, LOSS OF BUSINESS, LOSS OF INFORMATION
OR DATE, OR OTHER FINANCIAL LOSS ARISING OUT OF OR IN
CONNECTION WITH THE SALE, INSTALLATION, MAINTENANCE, USE,
PERFORMANCE, FAILURE, OR INTERRUPTION OF THE POSSIBILITY OF
SUCH DAMAGES, AND LIMITS |ITS LIABILITY TO REPAIR,
REPLACEMENT, OR REFUND OF THE PURCHASE PRICE PAID, AT
TRENDNET’S OPTION. THIS DISCLAIMER OF LIABILITY FOR DAMAGES
WILL NOT BE AFFECTED IF ANY REMEDY PROVIDED HEREIN SHALL
FAIL OF ITS ESSENTIAL PURPOSE.

Governing Law: This Limited Warranty shall be governed by the
laws of the state of California.

Some TRENDnet products include software code written by third
party developers. These codes are subject to the GNU General
Public License ("GPL") or GNU Lesser General Public License
("LGPL").
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Go to http://www.trendnet.com/gpl or http://www.trendnet.com
Download section and look for the desired TRENDnet product to
access to the GPL Code or LGPL Code. These codes are distributed
WITHOUT WARRANTY and are subject to the copyrights of the
developers. TRENDnet does not provide technical support for these
codes. Please go to http://www.gnu.org/licenses/gpl.txt or
http://www.gnu.org/licenses/lgpl.txt for specific terms of each
license.
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